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Question Number : 1 Question Id : 25498942244 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
The most important or powerful computer in a typical network is a ______.
Options :
1.  desktop
2.  network station
3.  network client
4.  network server
  



Question Number : 1 Question Id : 25498942244 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
एक परंपरागत नेटवक�  म� सबसे मह�पूण� या श��शाली कं�ूटर को ______ कहते ह�।
Options :
1.  डे�टॉप
2.  नेटवक�  �ेशन
3.  नेटवक�  �ाइंट
4.  नेटवक�  सव�र
  
Question Number : 2 Question Id : 25498942245 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
What is an E-mail?
Options :
1.  An internet standard, which allows users to upload and download files.
2.  An online area on which a user can converse in written form about any special subject.
3.  Transmission of files and messages through computer network.
4.  A real time typed conversation.
  
Question Number : 2 Question Id : 25498942245 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
ई-मेल �ा होता है?
Options :
1.  इंटरनेट का एक मानक, िजसकी मदद से यूज़स� फ़ाइल� अपलोड या डाउनलोड कर सकते ह�।
2.  एक ऑनलाइन �ैटफ़ॉम�, जहां पर यूज़र िकसी खास िवषय पर िल�खत संचार कर सकता है।
3.  कं�ूटर नेटवक�  के मा�म से फ़ाइलो ंऔर संदेशो ंका ट� ांसिमशन।
4.  एक �रयल टाइम िल�खत (टाइ�ड) संवाद।
  
Question Number : 3 Question Id : 25498942246 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
A ______ contains commands that can be selected.
Options :



1.  Pointer
2.  Menu
3.  Icon
4.  Button
  
Question Number : 3 Question Id : 25498942246 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
एक ______ म� कमांड होते ह� िज�� चुना जा सकता है।
Options :
1.  पॉइंटर
2.  मे�ू
3.  आइकन
4.  बटन
  
Question Number : 4 Question Id : 25498942247 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Internet is a network of:
Options :
1.  computers
2.  terminal
3.  networks
4.  mail Server
  
Question Number : 4 Question Id : 25498942247 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
इंटरनेट िकस का एक नेटवक�  है?
Options :
1.  कं�ूटर का
2.  टिम�नल का
3.  नेटव�� का



4.  मेल सव�र का
  
Question Number : 5 Question Id : 25498942248 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
To insert a picture into MS Word document, which of the following methods is used?
Options :
1.  Insert > Picture command
2.  Insert > Object command
3.  Add > Picture command
4.  Insert > File command
  
Question Number : 5 Question Id : 25498942248 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन� म� से िकस प�ित का उपयोग  MS Word डॉ�ुम�ट म� िच� स��िलत करने के िलए िकया जाता है?
Options :
1.  Insert > Picture command
2.  Insert > Object command
3.  Add > Picture command
4.  Insert > File command
  
Question Number : 6 Question Id : 25498942249 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Duplication of data is known as ______.
Options :
1.  data inconsistency
2.  data repentance
3.  data redundancy
4.  data error
  
Question Number : 6 Question Id : 25498942249 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



डेटा के दोहरीकरण को ______ के �प म� जाना जाता है।
Options :
1.  डेटा इ��ी��सी
2.  डेटा �रप�टंस 
3.  डेटा �रड��सी 
4.  डाटा एरर
  
Question Number : 7 Question Id : 25498942250 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following data types is used to store objects such as images, documents and graphs?
Options :
1.  Hyperlink
2.  OLE Object
3.  Text
4.  Description
  
Question Number : 7 Question Id : 25498942250 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सा डेटा �कार व�ुओ,ं द�ावेजो,ं और �ाफ जैसे व�ुओ ंको सं�हीत करने के िलए उपयोग िकया जाता है?
Options :
1.  हाइपरिलंक
2.  OLE ऑ�े�
3.  टे�
4.  िववरण (िड���शन)
  
Question Number : 8 Question Id : 25498942251 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
_______ is the process of saving information to the secondary storage device.
Options :
1.  Reading
2.  Hearing



3.  Writing
4.  Drawing
  
Question Number : 8 Question Id : 25498942251 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ ि�तीयक सं�हण िडवाइस म� जानकारी सहेजने की �ि�या है।
Options :
1.  रीिडंग
2.  िहय�रंग
3.  राइिटंग
4.  ड� ॉइंग
  
Question Number : 9 Question Id : 25498942252 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
CAD stand for:
Options :
1.  Computer Aided Design
2.  Computer Algorithm Design
3.  Computer Application in Design
4.  Computer Appliance Design
  
Question Number : 9 Question Id : 25498942252 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
CAD का पूण� �प �ा है?
Options :
1.  कं�ूटर एिडड िडजाईन (Computer Aided Design)
2.  कं�ूटर अ�ो�रथम िडजाईन (Computer Algorithm Design)
3.  कं�ूटर ए�ीकेशन इन िडजाईन (Computer Application in Design)
4.  कं�ूटर ए�ायंस िडजाईन (Computer Appliance Design)
  



Question Number : 10 Question Id : 25498942253 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following terms will be applied to the collection of all web pages of Amazon.com?
Options :
1.  Top-level domain
2.  Web site
3.  Web site address
4.  Web domain
  
Question Number : 10 Question Id : 25498942253 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Amazon.com के सभी वेब पृ�ो ंके सं�ह पर िन� म� से कौन सा श� लागू िकया जाएगा?
Options :
1.  टॉप-लेवल डोमेन
2.  वेबसाइट
3.  वेबसाइट एड� ेस
4.  वेब डोमेन
  
Question Number : 11 Question Id : 25498942254 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Using print preview is useful when you want to:
Options :
1.  colour the document
2.  save the document
3.  delete the document
4.  print the document
  
Question Number : 11 Question Id : 25498942254 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
ि�ंट �ी�ू को उपयोग करना उपयोगी होता है जब आप _______ चाहते ह�।
Options :



1.  डॉ�ूम�ट को कलर करना
2.  डॉ�ूम�ट को सेव करना
3.  डॉ�ूम�ट को िडलीट करना
4.  डॉ�ूम�ट को ि�ंट करना
  
Question Number : 12 Question Id : 25498942255 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Arithmetic logic unit and control sections have special purpose storage locations called:
Options :
1.  Registers
2.  RAM
3.  BIOS
4.  I/O
  
Question Number : 12 Question Id : 25498942255 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
अंकगिणतीय तक�  इकाई (अ�रथमेिटक लॉिजक यूिनट) और िनयं�ण खंडो ं(क�� ोल से�ंस) म� िवशेष उ�े� �ोरेज �थान होते ह� िज�� ______ कहा जाता है।
Options :
1.  रिज�स�
2.  RAM
3.  BIOS
4.  I/O
  
Question Number : 13 Question Id : 25498942256 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
What do you mean by Jacquard Loom?
Options :
1.  A bird found in Japan
2.  A weaving machine that used punched cards
3.  The first computer controlled loom
4.  A machine for writing match tables



  
Question Number : 13 Question Id : 25498942256 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
जैकवड� लूम का �ा अथ� है?
Options :
1.  जापान म� पाया जाने वाला एक प�ी
2.  एक बुनाई मशीन िजसने पंचड काड� का इ�ेमाल िकया
3.  लूम को िनयंि�त करने वाला पहला कं�ूटर
4.  मैच टेबल िलखने के िलए एक मशीन
  
Question Number : 14 Question Id : 25498942257 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following memories must be refreshed many times per second?
Options :
1.  Static RAM
2.  Dynamic RAM
3.  ROM
4.  EPROM
  
Question Number : 14 Question Id : 25498942257 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकस मेमोरी को �ित सेकंड कई बार �र�ेश िकया जाना चािहए?
Options :
1.  Static (�थैितक) RAM
2.  Dynamic (डायनािमक) RAM
3.  ROM
4.  EPROM
  
Question Number : 15 Question Id : 25498942258 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Multipurpose Internet Mail Extension (MIME) was developed to support:



Options :
1.  e-mail messages containing text, audio and video
2.  FTP clients
3.  telnet between two machines
4.  text–based e-mail messages only
  
Question Number : 15 Question Id : 25498942258 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
म�ीपप�ज (ब�उ�ेशीय) इंटरनेट मेल ए�ट�शन (MIME) को िकसके िलए िवकिसत िकया गया था?
Options :
1.  टे�, ऑिडयो और वीिडयो वाले ई-मेल संदेश
2.  एफ़टीपी �ाहक
3.  दो मशीनो ंके बीच टेलनेट
4.  पाठ-आधा�रत ई-मेल संदेश केवल
  
Question Number : 16 Question Id : 25498942259 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which device can understand the difference between data and programs?
Options :
1.  Input device
2.  Output device
3.  Memory
4.  Microprocessor
  
Question Number : 16 Question Id : 25498942259 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
कौन सी िडवाइस, डेटा और काय��मो ंके बीच अंतर को समझ सकती है?
Options :
1.  इनपुट िडवाइस
2.  आउटपुट िडवाइस



3.  मेमोरी
4.  माइ�ो�ोसेसर
  
Question Number : 17 Question Id : 25498942260 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
CD-ROM drive uses:
Options :
1.  magnetic storage technique
2.  optical storage technique
3.  solid state storage technique
4.  electronic storage technique
  
Question Number : 17 Question Id : 25498942260 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
CD-ROM ड� ाइव िकसका उपयोग करता है?
Options :
1.  चंुबकीय भंडारण तकनीक
2.  ऑि�कल भंडारण तकनीक
3.  सॉिलड � टेट भंडारण तकनीक
4.  इले�� ॉिनक भंडारण तकनीक
  
Question Number : 18 Question Id : 25498942261 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the below is the default file extension for MS Word documents?
Options :
1.  .txt
2.  .wrd
3.  .fil
4.  .doc or .docx
  
Question Number : 18 Question Id : 25498942261 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
MS Word फाइ� के िलए िन�िल�खत म� से कौनसा िडफ़ॉ� फाइल ए�ट�शन है?
Options :
1.  .txt
2.  .wrd
3.  .fil
4.  .doc या .docx
  
Question Number : 19 Question Id : 25498942262 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Refresh rate is measured in ______.
Options :
1.  mbps
2.  mega hertz
3.  kilo hertz
4.  hertz
  
Question Number : 19 Question Id : 25498942262 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
�र�ेश रेट को ______ म� मापा जाता है।
Options :
1.  mbps
2.  मेगा हट्�ज़
3.  िकलो हट्�ज
4.  हट्�ज़
  
Question Number : 20 Question Id : 25498942263 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which directory is NOT valid for Linux file system?
Options :
1.  /dev



2.  /mnt
3.  /etc
4.  /etm
  
Question Number : 20 Question Id : 25498942263 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िलन� फाइल िस�म के िलए कौन सी डायरे�री वैध नही ंहै?
Options :
1.  /dev
2.  /mnt
3.  /etc
4.  /etm
  
Question Number : 21 Question Id : 25498942264 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which file format is used to save Hypertext Markup Language web page file?
Options :
1.  .whtm
2.  .htm
3.  .htmw
4.  .htmlw
  
Question Number : 21 Question Id : 25498942264 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
हाइपरटे� माक� अप ल��ेज़ वेब पेज फाइल को सहेजने के िलए कौन से फ़ाइल फॉम�ट का उपयोग िकया जाता है?
Options :
1.  .whtm
2.  .htm
3.  .htmw
4.  .htmlw
  



Question Number : 22 Question Id : 25498942265 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which function key is used to visit Office.com?
Options :
1.  F1
2.  F2
3.  F3
4.  F4
  
Question Number : 22 Question Id : 25498942265 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Office.com पर जाने के िलए कौन सी फं�न कंुजी का उपयोग िकया जाता है?
Options :
1.  F1
2.  F2
3.  F3
4.  F4
  
Question Number : 23 Question Id : 25498942266 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ input device is generally used in banks because of a large number of cheques to be processed every day.
Options :
1.  MICR
2.  KEYBOARD
3.  SCANNER
4.  MOUSE
  
Question Number : 23 Question Id : 25498942266 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ इनपुट िडवाइस का उपयोग आम तौर पर ब�को ंम� हर िदन बड़ी सं�ा म� चेको ंको �ोसेस करने के िलए िकया जाता है।
Options :



1.  MICR
2.  कीबोड�
3.  �ैनर
4.  माउस
  
Question Number : 24 Question Id : 25498942267 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
In MS Excel, ______ is a type of pie chart.
Options :
1.  polar area
2.  bar
3.  column
4.  XY
  
Question Number : 24 Question Id : 25498942267 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
_____, MS Excel म� एक �कार का पाय चाट� है।
Options :
1.  पोलार ए�रया
2.  बार
3.  कॉलम
4.  XY
  
Question Number : 25 Question Id : 25498942268 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following is used to close a tab in Google Chrome browser?
Options :
1.  Ctrl+Y
2.  Ctrl+A
3.  Ctrl+W
4.  Ctrl+T



  
Question Number : 25 Question Id : 25498942268 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Google Chrome �ाउज़र म� टैब को बंद करने के िलए िन� म� से िकसका उपयोग िकया जाता है?
Options :
1.  Ctrl+Y
2.  Ctrl+A
3.  Ctrl+W
4.  Ctrl+T
  
Question Number : 26 Question Id : 25498942269 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ is a chart that is supposed to be placed on a worksheet as opposed to on a separate chart sheet when using a spread sheet software
package in MS Excel.
Options :
1.  Bar chart
2.  Column chart
3.  Embedded chart
4.  Stock chart
  
Question Number : 26 Question Id : 25498942269 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ एक चाट� है िजसे MS Excel म� एक फैल शीट सॉ�टवेयर पैकेज का उपयोग करते समय एक अलग चाट� शीट पर िवरोध के �प म� एक वक� शीट पर
रखा जाना चािहए।
Options :
1.  बार चाट�
2.  कॉलम चाट�
3.  ए�डेड़ चाट�
4.  �ॉक चाट�
  
Question Number : 27 Question Id : 25498942270 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
If a chart comprises of several categories, a ______ is needed to pinpoint the pattern in MS Excel.
Options :
1.  title
2.  legend
3.  scale
4.  source
  
Question Number : 27 Question Id : 25498942270 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
यिद चाट� म� कई वग� शािमल हो,ं तो MS Excel म� �परेखा को िनधा��रत करने के िलए _______ की आव�कता होती है।
Options :
1.  शीष�क (टाइटल)
2.  कथा (लेज�ड़)
3.  प�रमाण (�ेल)
4.  �ोत (सोस�)
  
Question Number : 28 Question Id : 25498942271 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
If a user attempts to access an area of a system that he/she should NOT be accessing, it is known as:
Options :
1.  legitimate access
2.  authorized access
3.  unauthorized access
4.  authentic access
  
Question Number : 28 Question Id : 25498942271 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
यिद कोई उपयोगकता� िस�म के िकसी ऐसे �े� तक प�ँच पाने की कोिशश करे जहाँ उसे नही ंजाना चािहए, तो इस ि�या को �ा कहते ह�?
Options :
1.  वैध प�ँच



2.  अिधकृत प�ँच
3.  अनिधकृत प�ँच
4.  �मािणक प�ँच
  
Question Number : 29 Question Id : 25498942272 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Automatic Number Identification serves a function similar to:
Options :
1.  Name
2.  Caller ID
3.  Mobile
4.  Internet
  
Question Number : 29 Question Id : 25498942272 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
ऑटोमैिटक नंबर आईड��िटिफ़केशन ______ की तरह काम करता है।
Options :
1.  नाम
2.  कॉलर ID
3.  मोबाइल
4.  इंटरनेट
  
Question Number : 30 Question Id : 25498942273 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following printers is used to reconstruct the ancient artifacts?
Options :
1.  Laser
2.  Dot Matrix
3.  3D
4.  LED
  



Question Number : 30 Question Id : 25498942273 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
�ाचीन कलाकृितयो ंके पुनिन�मा�ण के िलए िकस ि�ंटर का उपयोग िकया जाता है?
Options :
1.  लेज़र
2.  डॉट मैिट� �
3.  3D
4.  एलईडी
  
Question Number : 31 Question Id : 25498942274 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which printer is suited to print home work?
Options :
1.  Dot matrix
2.  Inkjet
3.  Thermal
4.  3D
  
Question Number : 31 Question Id : 25498942274 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
गृह काय� (होम वक� ) ि�ंट करने के िलए कौन सा ि�ंटर उपयु� है?
Options :
1.  डॉट मैिट� �
2.  इंकजेट
3.  थम�ल
4.  3D
  
Question Number : 32 Question Id : 25498942277 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
What is the keyboard shortcut to lock cell references in an MS-Excel formula?
Options :



1.  Ctrl
2.  F4
3.  F2
4.  Alt
  
Question Number : 32 Question Id : 25498942277 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
MS-Excel सू� म� सेल संदभ� लॉक करने के िलए कीबोड� शॉट�कट �ा है?
Options :
1.  Ctrl
2.  F4
3.  F2
4.  Alt
  
Question Number : 33 Question Id : 25498942278 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
How would you refer a leading spacing in typography?
Options :
1.  French spacing
2.  Line spacing
3.  Sentence spacing
4.  Letter spacing
  
Question Number : 33 Question Id : 25498942278 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
आप टाइपो�ाफी म� एक लीिडंग � पेस को � या संबोिधत कर� गे?
Options :
1.  �� च � पेिसंग
2.  लाइन � पेिसंग
3.  स��ट�स � पेिसंग
4.  लेटर � पेिसंग



  
Question Number : 34 Question Id : 25498942279 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following is a non-impact printer?
Options :
1.  Laser printer
2.  Band printer
3.  Drum printer
4.  Dot-matrix printer
  
Question Number : 34 Question Id : 25498942279 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा एक नॉन-इ�ै� ि�ंटर है?
Options :
1.  लेजर ि�ंटर
2.  ब�ड ि�ंटर
3.  ड� म ि�ंटर
4.  डॉट-मैिट� � ि�ंटर
  
Question Number : 35 Question Id : 25498942280 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ is the process of carrying out commands.
Options :
1.  Executing
2.  Fetching
3.  Storing
4.  Decoding
  
Question Number : 35 Question Id : 25498942280 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ कमांड को पूरा करने की �ि�या है।



Options :
1.  ए�े�ूिटंग (Executing)
2.  फेिचंग (Fetching)
3.  �ो�रंग (Storing)
4.  िडकोिडंग (Decoding)
  
Question Number : 36 Question Id : 25498942281 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Transducer which encodes data in the form of audio, video, images into a smaller form i.e. codec is called a(n):
Options :
1.  compressor
2.  video encoder
3.  email encoder
4.  audio encoder
  
Question Number : 36 Question Id : 25498942281 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
ट� ांस�ूसर, जो ऑिडयो, वीिडयो, छिवयो ंके डेटा को एक छोटे �प अथा�त कोडेक म� ए�ोड करता है, वह कहलाता है:
Options :
1.  कं�ेसर
2.  िविडयो ए�ोडर
3.  ईमेल एनकोडर
4.  ऑिडयो ए�ोडर
  
Question Number : 37 Question Id : 25498942282 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Text included in ______ is NOT automatically corrected.
Options :
1.  Hyperlinks
2.  Text box



3.  Footer
4.  Header
  
Question Number : 37 Question Id : 25498942282 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
जो पाठ (टे�) ______ म� शािमल (सि�िहत) होता है उसे �चािलत �प से दोषरिहत नही ंिकया जा सकता।
Options :
1.  हाइपरिलं�
2.  टे�बॉ�
3.  फूटर
4.  हेडर
  
Question Number : 38 Question Id : 25498942285 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
A ______ is a piece of programming code that runs in MS Excel environment and helps automate routine tasks.
 
Options :
1.  formula
2.  program
3.  macro
4.  module
  
Question Number : 38 Question Id : 25498942285 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ �ो�ािमंग कोड का एक भाग है जो MS Excel प�रवेश म� चलता है और िनयिमत काय� को �चािलत करने म� मदद करता है।
Options :
1.  फ़ॉमू�ला
2.  �ो�ाम
3.  मै�ो
4.  मॉ�ूल
  



Question Number : 39 Question Id : 25498942286 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
What is DPI?
Options :
1.  Depth per inch
2.  Dots per inch
3.  Density per inch
4.  Decoder per inch
  
Question Number : 39 Question Id : 25498942286 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
DPI �ा है?
Options :
1.  डे�थ पर इंच (Depth per inch)
2.  डॉट्स पर इंच (Dots per inch)
3.  ड��िसटी पर इंच (Density per inch)
4.  िडकोडर पर इंच (Decoder per inch)
  
Question Number : 40 Question Id : 25498942287 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
What is the full form of DCT that is used in video compression?
Options :
1.  Discrete Cosine Transform
2.  Direct Convolution Technique
3.  Direct Cosine Technique
4.  Discrete Convolution Transform
  
Question Number : 40 Question Id : 25498942287 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िजस DCT का �योग वीिडयो संपीड़न िकया जाता है उसका पूण� �प �ा है ?
Options :



1.  िड�ीट कोसाइन ट� ांसफॉम� (Discrete Cosine Transform)
2.  डायरे� को�ो�ूशन टेकनीक (Direct Convolution Technique)
3.  डायरे� कोसाइन टेकनीक (Direct Cosine Technique)
4.  िड�ीट को�ो�ूशन ट� ांसफॉम� (Discrete Convolution Transform)
  
Question Number : 41 Question Id : 25498942290 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following displays the name of a Word document?
Options :
1.  Task bar
2.  Title bar
3.  Menu bar
4.  Tool bar
  
Question Number : 41 Question Id : 25498942290 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा एक Word (वड�) द�ावेज का नाम �दिश�त करता है?
Options :
1.  टा� बार (Task bar)
2.  टाइिटल बार (Title bar)
3.  मेनू बार (Menu bar)
4.  टूल बार (Tool bar)
  
Question Number : 42 Question Id : 25498942291 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Select one option from below options that does NOT facilitate to run more than one program at a time:
Options :
1.  Windows
2.  Linux
3.  DOS
4.  Unix



  
Question Number : 42 Question Id : 25498942291 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन� म� से उस िवक� का चयन कर�  िजसम� एक समय म� एक से अिधक �ो�ामो ंके चलने की सुिवधा नही ंहोती है।
Options :
1.  Windows
2.  Linux
3.  DOS
4.  Unix
  
Question Number : 43 Question Id : 25498942292 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
The keyboard shortcut key combination for entering/displaying Registered trademark symbol in MS Word is:
Options :
1.  ALT+Enter
2.  CTRL+ALT+R
3.  CTRL+TAB+Shift
4.  CTRL+SHIFT+ESC
  
Question Number : 43 Question Id : 25498942292 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
पंजीकृत ट� ेडमाक�  को �दिश�त करने के िलए कंुजी संयोजन �ा है?
Options :
1.  ALT+Enter
2.  CTRL+ALT+R
3.  CTRL+TAB+Shift
4.  CTRL+SHIFT+ESC
  
Question Number : 44 Question Id : 25498942302 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
To improve your Internet browser performance:



Options :
1.  Install another browser.
2.  Clear cookies and Internet temporary files frequently.
3.  Do not open multiple tabs.
4.  Change wired internet connection to WiFi connection.
  
Question Number : 44 Question Id : 25498942302 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
अपने इंटरनेट �ाउज़र के �दश�न को बेहतर बनाने के िलए �ा कर� गे?
Options :
1.  एक और �ाउज़र �थािपत कर�।
2.  कुकीज़ और इंटरनेट अ�थायी फ़ाइलो ंको अ�र साफ़ (��यर) कर�।
3.  ब�िवध (म�ी�) टैब न खोल�।
4.  वायड� कने�न को वाईफाई कने�न म� बदल द�।
  
Question Number : 45 Question Id : 25498942303 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the below menu commands is used to apply design template in PowerPoint 2013?
Options :
1.  Tools → Slide design
2.  View → Slide design
3.  Insert → Slide design
4.  Format → Slide design
  
Question Number : 45 Question Id : 25498942303 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
PowerPoint 2013 म� िन� म� से िकस कमांड का उपयोग िडज़ाइन ट�पलेट लागू करने के िलए िकया जाता है?
Options :
1.  Tools → Slide design
2.  View → Slide design
3.  Insert → Slide design



4.  Format → Slide design
  
Question Number : 46 Question Id : 25498942304 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
A ______ is a process that runs in the background, usually waiting for something to happen that it is capable of working with.
Options :
1.  daemon
2.  monster
3.  ghost
4.  giant
  
Question Number : 46 Question Id : 25498942304 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ बैक�ाउंड म� चलने वाली एक �ोसेस है जो कुछ ऐसा घटने के िलए इंतज़ार करती है िजसके साथ वह काम कर सके।
Options :
1.  डेमन
2.  मा�र
3.  घो�
4.  ज़ाइअ�
  
Question Number : 47 Question Id : 25498942312 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
In a pen type barcode reader, the photodiode generates a waveform that is used to measure the ______ in the bar code.
Options :
1.  wavelength of light
2.  widths of the bars and spaces
3.  density of light
4.  variance of light
  
Question Number : 47 Question Id : 25498942312 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



पेन टाइप बारकोड रीडर म�, फोटोडायोड एक तरंग उ�� करता है िजसका उपयोग बारकोड म� ______ को मापने के िलए िकया जाता है।
Options :
1.  �काश के तरंग दै��
2.  बार की चौड़ाई और खाली �थान
3.  �काश के घन�
4.  �काश के िवचरण
  
Question Number : 48 Question Id : 25498942313 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
In a triple layer Recordable Blu-ray Disc, what is the cover layer thickness of L2 layer?
Options :
1.  57 µm
2.  100 µm
3.  75 µm
4.  65 µm
  
Question Number : 48 Question Id : 25498942313 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िट� पल लेयर �रकॉड�बल � लू-रे िड� क म�, L2 लेयर के कवर लेयर की मोटाई िकतनी होती है?
Options :
1.  57 µm
2.  100 µm
3.  75 µm
4.  65 µm
  
Question Number : 49 Question Id : 25498942314 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which of the following does NOT belong to the Statistical function category in MS Excel?
Options :
1.  AND()
2.  LARGE()



3.  COUNT()
4.  AVERAGE()
  
Question Number : 49 Question Id : 25498942314 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
MS Excel म� इनम� से िकसका संबंध �ैिट��कल फ़ं�न कैटेगरी से नही ंहै?
Options :
1.  AND()
2.  LARGE()
3.  COUNT()
4.  AVERAGE()
  
Question Number : 50 Question Id : 25498942315 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Video conferencing is a live _____-based meeting between people.
Options :
1.  video
2.  audio
3.  offline
4.  paper
  
Question Number : 50 Question Id : 25498942315 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
वीिडयो कॉ��� �िसंग लोगो ंके बीच एक लाइव _____ आधा�रत बैठक है।
Options :
1.  वीिडयो
2.  ऑिडयो
3.  ऑफ़लाइन
4.  कागज
  
Question Number : 51 Question Id : 25498942316 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
We can get files from another computer connected to Internet using ______.
Options :
1.  TELNET
2.  FTP
3.  HTTP
4.  USB
  
Question Number : 51 Question Id : 25498942316 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ का इ�ेमाल करके हम इंटरनेट से जुड़े िकसी दूसरे कं�ूटर से फाइल� �ा� कर सकते ह�।
Options :
1.  TELNET
2.  FTP
3.  HTTP
4.  USB
  
Question Number : 52 Question Id : 25498942317 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ can be best described as a digital media receiver.
Options :
1.  Apple TV
2.  Twitter
3.  Yahoo Live
4.  Windows Live
  
Question Number : 52 Question Id : 25498942317 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
______ को सबसे उिचत �कार से िडिजटल मीिडया �रसीवर कहा जा सकता है।
Options :
1.  ए�ल टीवी



2.  ि�टर
3.  या� लाइव
4.  िवंडोज लाइव
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Questions : No
Question Numbers : (53 to 57)
Chamundi Hills

Hills and mountains have special significance in Hinduism, and some exquisite temples atop hills serve as constant reminders of the beauty of
creation.

The Chamundi Hills, near Mysore, is one such ancient hill, with a temple atop dedicated to Goddess Durga worshipped as Chamundesvari.
Chamundi or Durga is the fierce form of Shakti. She is the slayer (killer) of the demons, Chanda and Munda and also Mahishasura, the buffalo
headed monster. The Goddess is the patron deity of the Mysore royal family. The temple is more than 1,000 years old.

With an average elevation of over 3,300 feet, the temple at the top is reached through an ancient stone stairway of 1,008 steps. At present, there is
a good motorable road to the top. Bus services, for the convenience of pilgrims and others, operates regularly.

About half way to the summit, there is an imposing 16 feet tall and 25 feet long statue of Nandi (the third largest in India), the vahana of Lord
Siva, carved out of a single piece of black granite. Close to the temple is a gigantic and colourful statue of Mahishasura, the buffalo demon



conquered by the Goddess, bearing a sword in his right hand and a cobra in the left.

The Devi Purana praises the virtues of Chamundesvari. The beautiful icon of the goddess, seated in yogic posture in the temple, is beautiful,
attractive and mesmerising, especially during the Navaratri festival when the icon is decorated with countless jewellery donated by the royal
household from time to time. The idol is carried on a decorated elephant as part of the celebrations during the annual Dussera Festival.

The temple attracts a large number of devotees from all over the world. While fervent devotees pray for fulfillment of their aspirations, all
visitors enjoy the enchanting scenery, including a panoramic view of the Mysore Palace.
Sub questions
 
Question Number : 53 Question Id : 25498942297 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Where are the Chamundi hills situated?
Options :
1.  Bengaluru
2.  Chennai
3.  Madurai
4.  Mysore
 
Question Number : 54 Question Id : 25498942298 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Chamundi hill temple is dedicated to:
Options :
1.  Goddess Durga
2.  Goddess Lakshmi
3.  Goddess Saraswati
4.  Goddess Kali
 
Question Number : 55 Question Id : 25498942299 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
In what form is Devi Durga worshipped in Chamundi hill temple?
Options :
1.  Mahishasura Mardini
2.  Annapurna



3.  Chamundeshwari
4.  Vaishno Devi
 
Question Number : 56 Question Id : 25498942300 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Besides the temple, what other object interests the tourists in Chamundi hills? Of the options given below, which one is NOT CORRECT?
Options :
1.  The statue of God Shiva.
2.  The statue of Nandi.
3.  Huge colourful statue of Mahishasura.
4.  The beautiful scenery and view of Mysore palace.
 
Question Number : 57 Question Id : 25498942301 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
The beautiful icon of the goddess is decorated during
Options :
1.  the Ugadi Festival
2.  the Holi Festival
3.  the Navaratri Festivals
4.  Diwali
  
Question Id : 25498942296 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No
Question Numbers : (53 to 57)
चामंुडी िह�

िहंदू धम� म� पहािड़यो ंऔर पहाड़ो ंका िवशेष मह� है और पहािड़यो ंके ऊपर कुछ उ�ृ� मंिदर सृि� की संुदरता की िनरंतर अनु�ारक के �प म� काय� करते
ह�।

मैसूर के िनकट ��थत चामंुडी िह� एक ऐसी �ाचीन पहाड़ी है, िजसम� देवी दुगा� को समिप�त मंिदर के साथ चामंुडे�री की पूजा की जाती है। चामंुडी या दुगा�
श�� का उ� �प है। वह रा�सो,ं चंड और मंुड के साथ-साथ मिहषासुर की भी विधक है, जो एक भैस के िसर वाला दै� था। यह देवी मैसूर के शाही प�रवार
की संर�क देवता है। यह मंिदर 1000 से भी अिधक वष� पुराना है।



3,300 फीट की औसत ऊंचाई के साथ, मंिदर की चोटी तक प�ंचने के िलए �ाचीन प�र वाली 1,008 सीिढ़यो ंसे होकर गुजरना पड़ता है। वत�मान म�, मंिदर की
चोटी पर प�ंचने के िलए एक बिढ़या मोटर चलने यो� सड़क का िनमा�ण िकया गया है। तीथ�याि�यो ंऔर दूसरे लोगो ंकी सुिवधा के िलए बस सेवाएँ िनयिमत �प
से संचािलत होती ह�।

िशखर के करीब आधे रा�े म�, 16 फीट लंबी और 25 फीट चौड़ी नंदी (भारत म� तीसरा सबसे बड़ा), भगवान िशव के वाहन की मूित� है, िजसका िनमा�ण काले
�ेनाइट के टुकड़े से �आ है। मंिदर के नजदीक मिहषासुर, की एक िवशाल और रंगीन मूित� है, जो एक भैस के िसर वाला दै� था और िजसे देवी दुगा� ने परा�
कर िदया है, देवी दुगा� के दािहने हाथ म� तलवार और बाएँ हाथ म� नाग है।

देवी पुराण म� चामंुडे�री के गुणो ंकी �शंसा की गई है। मंिदर म� योग मु�ा म� बैठी देवी की संुदर, आकष�क और मं�मु� �ितमा है, खासकर जब नवराि� �ोहार
के दौरान जब शाही प�रवार �ारा समय-समय पर दान िकए गए अनिगनत आभूषणो ंसे इस �ितमा को सजाया जाता है, तो यह और अिधक संुदर िदखती है।
दशहरा के वािष�क �ोहार के दौरान, उ�व के िह�े के �प म� मूित� को सजाए गए हाथी पर ले जाया जाता है।

यह मंिदर बड़ी सं�ा म� िव� भर के भ�ो ंको आकिष�त करता है। जबिक उ�ाही भ� अपनी आकां�ाओ ंकी पूित� के िलए �ाथ�ना करते ह�, सभी आगंतुक
मैसूर महल के मनोरम �� सिहत आकष�क ��ो ंका आनंद लेते ह�।
Sub questions
 
Question Number : 53 Question Id : 25498942297 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
चामंुडी िह� कहाँ ��थत ह�?
Options :
1.  ब�गलु�
2.  चे�ई
3.  मदुरै
4.  मैसूर
 
Question Number : 54 Question Id : 25498942298 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
चामंुडी िहल मंिदर िकस देवी को समिप�त है?
Options :
1.  देवी दुगा�
2.  देवी ल�ी
3.  देवी सर�ती
4.  देवी काली



 
Question Number : 55 Question Id : 25498942299 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
देवी दुगा� की पूजा चामंुडी िहल मंिदर म� िकस �प म� की जाती है?
Options :
1.  मिहषासुर मिद�नी
2.  अ�पूणा�
3.  चामंुडे�री
4.  वै�ो देवी
 
Question Number : 56 Question Id : 25498942300 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
मंिदर के अलावा, चामंुडी िह� म� पय�टको ंकी िकस अ� व�ु म� �िच है? नीचे िदए गए िवक�ो ंम� से कौन सा सही नही ंहै?
Options :
1.  भगवान िशव की मूित�।
2.  नंदी की मूित�।
3.  मिहषासुर की िवशाल रंगीन मूित�।
4.  मैसूर महल के संुदर और मनोरम ��।
 
Question Number : 57 Question Id : 25498942301 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
देवी की संुदर �ितमा को कब सजाया जाता है?
Options :
1.  उगादी का �ोहार
2.  होली का �ोहार
3.  नवराि� का �ोहार
4.  िदवाली
  
  

QUANTITATIVE APTITUDE
Section Id : 2549894651



Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894692
Question Shuffling Allowed : Yes
  
Question Number : 58 Question Id : 25498942288 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Evaluate the following expression. (You are not expected to calculate the exact value)

32.1 × 2799 ÷ 549 + 120 = ?
Options :
1.  220
2.  284
3.  375
4.  505
  
Question Number : 58 Question Id : 25498942288 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत �ंजक को हल कर�। (आपको सटीक मान की गणना नही ंकरनी है)   

32.1 × 2799 ÷ 549 + 120 = ?
Options :
1.  220
2.  284
3.  375
4.  505
  



Question Number : 59 Question Id : 25498942289 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
What approximate value should come in place of the question mark (?) in the following expression?
(You are not expected to calculate the exact value)

335.01 × 244.99 ÷ 55 = ?
Options :
1.  1490
2.  1550
3.  1420
4.  1590
  
Question Number : 59 Question Id : 25498942289 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत �ंजक म� �� िच� (?) के �थान पर अनुमािनत मान �ा होना चािहए?
(आपको सटीक मान की गणना नही ंकरनी है)

335.01 × 244.99 ÷ 55 = ?
Options :
1.  1490
2.  1550
3.  1420
4.  1590
  
Question Number : 60 Question Id : 25498942307 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  



3.  

4.  

  
Question Number : 60 Question Id : 25498942307 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498942308 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Options :



1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498942308 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498942309 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Options :

1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498942309 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498942310 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Options :

1.  



2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498942310 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
  

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549894652
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6



Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894693
Question Shuffling Allowed : Yes
  
Question Number : 64 Question Id : 25498942276 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Highbrow is related to Cultivated in the same way as Suave is related to:
Options :
1.  Elegant
2.  Urbane
3.  Stylish
4.  Broad-minded
  
Question Number : 64 Question Id : 25498942276 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
उ� बु��मान, सुसं�ृत से िजस �कार संबंिधत है उसी �कार िश� िन�िल�खत म� से िकससे संबंिधत है?
Options :
1.  आिभजा� (Elegant)
2.  भ� (Urbane)
3.  सु�िचपूण� (Stylish)
4.  उदार (Broad-minded)
  
Question Number : 65 Question Id : 25498942293 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
In the following question, a group of three/four inter – related words is given. Choose a word from the given alternatives that is similar to the
given words and hence belongs to the same group.

Canada : Chile : Germany
Options :
1.  Spain
2.  Paris



3.  Chicago
4.  Ottawa
  
Question Number : 65 Question Id : 25498942293 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत �� म� आपस म� स�ंिधत तीन/चार श�ो ंके समूह िदए गए ह�। िदए गए चार िवक�ो ंम� उस श� का चयन कर�  जो इनसे स�ंिधत हो और इस
समूह का ही हो।

कनाडा : िचली : जम�नी
Options :
1.  �ेन
2.  पे�रस
3.  िशकागो
4.  ओटावा
  
Question Number : 66 Question Id : 25498942294 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
The following question consists of a pair of numbers that have a certain relationship to each other, followed by four other pairs of numbers given
as alternatives. Select the pair in which the numbers are similarly related as in the given pair.

7 : 24
Options :
1.  30 ∶ 100
2.  23 ∶ 72
3.  19 ∶ 58
4.  11 ∶ 43

  
Question Number : 66 Question Id : 25498942294 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत �� म�, नंबरो ंका एक जोड़ा िदया गया है िजनका आपस म� कुछ िनि�त संबंध है, साथ ही िवक�ो ंके �प म�, नंबरो ंके चार अ� जोड़े भी िदए गए
है। िवक�ो ंम� से, नंबरो ंके उस जोड़े का चयन कर�  िजनका आपस म� वैसा ही संबंध है, जैसा िक पहले िदए गए नंबरो ंके जोड़े के बीच है।



7 : 24
Options :
1.  30 ∶ 100
2.  23 ∶ 72
3.  19 ∶ 58
4.  11 ∶ 43

  
Question Number : 67 Question Id : 25498942295 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
In each of the following, four words have been given, out of which three are alike in some manner, while the fourth one is different. Choose out
the odd one.
Options :
1.  Sparrow
2.  Eagle
3.  Hawk
4.  Vulture
  
Question Number : 67 Question Id : 25498942295 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
नीचे िवक�ो ंम� चार श� िदए गए ह� िजनम� से तीन िकसी �कार से एक जैसे ह�, जबिक एक इनसे िभ� है। उस िभ� श� की पहचान कर�।
Options :
1.  गौरैया
2.  चील
3.  बाज़
4.  िग�
  
Question Number : 68 Question Id : 25498942305 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
There is a certain relationship between the first two words. Select the correct option which has the same relationship with the third word.



Radio : Listener :: Film : ?
Options :
1.  Producer
2.  Actor
3.  Viewer
4.  Director
  
Question Number : 68 Question Id : 25498942305 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
पहले दो श�ो ंके बीच कोई संबंध है। उस सही िवक� का चयन कर�  िजसका तीसरे श� से वैसा ही संबंध है।

रेिड़यो : �ोता :: िफ� : ?
Options :
1.  िनमा�ता
2.  अिभनेता
3.  दश�क
4.  िनदेशक
  
Question Number : 69 Question Id : 25498942306 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Select the option that is related to the third word in the same way as second word is related to the first.

Novice : Learner  ::  Harbinger : ?
Options :
1.  Messenger
2.  Thief
3.  Pickpocket
4.  Robber
  
Question Number : 69 Question Id : 25498942306 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
उस िवक� को चुने जो तीसरे श� से उसी �कार स�ंिधत है िजस �कार से दूसरा श� पहले श� से स�ंिधत है।



नौिस�खया : िश�ाथ�  :: अ�दूत : ?
Options :
1.  संदेशवाहक
2.  चोर
3.  जेबकतरा
4.  लुटेरा
  
  

GENERAL AWARENESS
Section Id : 2549894653
Section Number : 5
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894694
Question Shuffling Allowed : Yes
  
Question Number : 70 Question Id : 25498942242 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
New oil fields in upper Assam are in:
Options :
1.  Naharkatia and Moran
2.  Ankleshwar and Navagram
3.  Kalol and Sobhasan
4.  Dibrugarh
  
Question Number : 70 Question Id : 25498942242 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
ऊपरी असम म� नए तेल �े� कहां ��थत ह�?
Options :
1.  नहरकिटया और मोरन
2.  अंकले�र और नवागांव
3.  कलोल और सोभासन
4.  िड�ूगढ़
  
Question Number : 71 Question Id : 25498942243 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Branch of biology in which we study about cultivation of flowering plant is called ______.
Options :
1.  Phenology
2.  Floriculture
3.  Agronomy
4.  Botany
  
Question Number : 71 Question Id : 25498942243 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
जीव िव�ान की वह शाखा कौन सी है, िजसम� हम फूल-पौधे की खेती के बारे म� अ�यन करते ह�?
Options :
1.  फ़ीनोलॉजी (Phenology)
2.  �ोरीक�चर (Floriculture)
3.  ए�ोनोमी (Agronomy)
4.  बॉटनी (Botany)
  
Question Number : 72 Question Id : 25498942275 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
When was the first National Forest Policy issued by the Government of India?
Options :
1.  1940



2.  1942
3.  1952
4.  1999
  
Question Number : 72 Question Id : 25498942275 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
भारत सरकार �ारा सव��थम रा�� ीय वन पॉिलसी कब जारी की गई थी?
Options :
1.  1940
2.  1942
3.  1952
4.  1999
  
Question Number : 73 Question Id : 25498942283 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Cataract blinds at least 120 million people globally every year. What is its main cause?
Options :
1.  Heredity
2.  Ultraviolet radiation
3.  Unbalance diet
4.  Gasoline furnace
  
Question Number : 73 Question Id : 25498942283 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
मोितयािब� (कैटरै�) से �ित वष� पूरे िव� म� कम से कम 120 लाख लोग अंधे हो जाते ह�। इसका मु� कारण �ा है?
Options :
1.  आनुवंिशकता
2.  अ�� ावायलट िविकरण
3.  असंतुिलत आहार
4.  गैसोिलन फन�स



  
Question Number : 74 Question Id : 25498942284 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
The term ‘bogey’ is associated with:
Options :
1.  tennis
2.  golf
3.  baseball
4.  chess
  
Question Number : 74 Question Id : 25498942284 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
श� ‘बोगी’ िकसके साथ जुड़ा है?
Options :
1.  टेिनस
2.  गो�फ़
3.  बेसबॉल
4.  शतरंज
  
Question Number : 75 Question Id : 25498942311 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
DDT and BHC may act as:
Options :
1.  allergens
2.  carcinogens
3.  asthamatic agents
4.  none of the given options
  
Question Number : 75 Question Id : 25498942311 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
DDT और BHC िन�िल�खत मे से िकस �प म� काम कर सकते ह�?



Options :
1.  एलज� कारक
2.  क� सर कारक
3.  दमा कारक
4.  िदए गए िवक� म� से कोई भी नही ं
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Group Number : 2
Group Id : 2549892982
Group Maximum Duration : 5
Group Minimum Duration : 5
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Edit Attended Group? : No
Break time : 1
Mandatory Break time : Yes
Group Marks : 0
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English Mock
Section Id : 2549894654
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894695
Question Shuffling Allowed : No



  
Question Number : 76 Question Id : 25498942319 Question Type : TYPING TEST
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children have
fun during this process as they get to explore new arenas.
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Paragraph Display : Yes
Evaluation Mode : Non Standard
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
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Actual
Group Number : 3
Group Id : 2549892983
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 0
Group Marks : 0
Is this Group for Examiner? : No
  
  

English Typing Test
Section Id : 2549894655
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory



Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894696
Question Shuffling Allowed : No
  
Question Number : 77 Question Id : 25498942318 Question Type : TYPING TEST
Self love and happiness are not found, they are created. Loving yourself is the most productive thing you can do for your life because all
that doubt and underestimating is holding you back from reaching your full potential. Therefore, it is very important to fall in love with
oneself. Learning to love yourself is a journey that teaches you short lessons and helps you increase genuine happiness in your life. Here
are some effective ways to learn to love yourself and be happy. Cast out of the idea that you have to be perfect. First of all, you need to
understand that perfection does not exist. Everyone in this world has a different perspective. Therefore, the idea of perfection differs
from one person to another. The good news is that you are perfect in your imperfection. Understand that the expectations of the society
are an unrealistic standard that can never be met. It is our human nature to always be hungry for more. Even if you hit that unrealistic
standard, you will always want more. As a result, you will become unhappy. So, do not compare yourself or your life to that unrealistic
standard. Try to be happy with what you have. Work on your progress and not on what others expect from you. Live in the moment
every day. Take a moment to look into yourself. See where you have come from and appreciate the beauty of the moment. Appreciate
that you are living, breathing, and functioning as a human being, which is the best gift of God. Daily gratitude. This is the key to
happiness. Spend 3 minutes each day, thinking of all the things you are grateful for and jot them down in a notebook. When you start
writing such things every day, you will start feeling positive and happy about yourself. Embrace the fact that you cannot control
everything. You can only control your reactions. What other people think of you is not under your control. Life is all about how you react
to the situations. So, instead of trying to get a hold over everything and everyone, do the best you can do and leave it to work itself out.
Care about self. Self care is the easiest way to find happiness. No matter what people and society say, you must take out time from your
busy schedule to pamper yourself and do things that put a smile on your face. Stay away from negative people. Be it on social media or
your personal life, try to remove all the negative people from your circle. Be with people who motivate you, correct your mistakes and
make you feel positive about everything. Always fill your mind with positive information and you will have a positive life. These are the
quick fire lessons you need to learn to be happy. Practice them daily so that they get incorporated into your habit. Once you start loving
yourself, your life will improve, you will be happiness and attract numerous opportunities to flourish. Happiness is right in front of you,
if only you choose to find it and practice it.
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